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Introduction



Introducing

1 Record, 2 Playback, 3 Collaborate
It's that simple!

The Just-In-Time Communicator
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Simply Powerful
Combine slides, voice, and 
annotation into an easy to use 
communication environment
No learning curve
Develop your material in 
PowerPoint – Lecture123 
does the rest
Integrated whiteboard
Immediately available for 
interactive web-based 
playback
Searchable, reusable, and 
editable
No pre or post production 
costs
Excellent playback quality 
over standard phone lines 

Questions asked during 
playback are answered by 
your faculty/expert and  
automatically integrated into 
the content
Monitor playback usage and 
Question/Answer exchange
Simple URL integration
Content metamorphosis with a 
repository of knowledge 
objects
Operates with firewalls and 
proxies
Adaptable to new 
technologies and devices, e.g. 
Blackberries, iPods
Java and Web based for all 
computing platforms
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Simplicity is the Key

• Most users of these Lecture123 tools do not need to 
read this whole document  :-)

• The main features are intuitive and easy to learn and use 
– some have used it without ever seeing it before, no 
training whatsoever.

• This document is large as it runs through a step-by-step 
screen shot tour and that takes space. 

• Use these slides to fit your needs: read everything or use 
it as needed for reference.
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Using this Tutorial
• These slides use actual screen shots of the Lecture123 

system along with text narrative.

• We suggest you step through this tutorial with 2 windows 
side-by-side on your computer desktop

– these slides

– http://www.lecture123.com in a browser

• The Presenter and Lecture123 Player applications are 
launched from this web site. Those program windows can 
be resized to fit on your desktop next to these slides.

• Another good resource is the Getting Started web page:
http://www.lecture123.com/elearning/gettingstarted.html
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Repositories
• Lecture123 supports repositories for access and storage 

of sessions
• These repositories may be different for each 

organization to protect information and provide branding
• Typically the repository name follows the main URL, e.g. 

http://www.lecture123.com/abc, where abc is the 
repository name

• URL references in this manual point to the generic 
repository named elearning

• You may need to substitute the repository name portion, 
e.g. perhaps 
http://www.lecture123.com/elearning/index.html
may become
http://www.lecture123.com/abc/index.html
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Objectives
• Learn how to perform the one time installation.

• Run through the main features of the Presenter 
application to record a session. 

• View recorded sessions in the Lecture123 
Player to become familiar with the basic features 
of playback.

• Use the QA (Question/Answer) collaboration 
layer: viewers post questions, content owners 
(authors) reply (later, in their own time)  with 
answers.
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System Overview



Orientation
• The Lecture123 system provides a set of applications that allow you to 

record content and publish for playback over the Internet. Playback 
includes a collaborative layer for posting and getting answers to 
questions automatically integrated into the content.

• Additionally there is a set of tools to manage your content.

• Everything is web based. Some tools run directly in any web browser. 
Others run as Java applications on your computer.

• The 2 main programs are:

– Presenter – records your content in either a whiteboard mode or using 
PowerPoint as your base slides. Your voice, pen or mouse annotations, and 
slide navigations are recorded. The session is then easily published for 
playback.

– Lecture123 Player – provides the player for viewing sessions already 
recorded with the Presenter.
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In a nutshell…
• Simple, natural content presentation, 

recording, playback with collaboration –
bringing asynchronous learning close to 
synchronous

• Prepare content as usual, e.g. PowerPoint, Word

• Open that file in the Lecture123 Presenter

• Present and record your content with slides, whiteboard, 
navigation, voice, and annotations

• Publish with a single click for immediate playback over 
the Internet

• Participants collaborate with QA

• QA and slide text content can be searched
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Lecture123

1. Record: Lecture123 Presenter
– PowerPoint slides (upcoming: anything that can print)
– author's voice
– annotate slides or add whiteboard slides during the lecture using 

"scribble"
2. Playback: Lecture123 Player

– on participants' computers anywhere, anytime
– synchronized slides with audio and "scribble"

3. Collaborate: QA
– participants ask questions during playback
– Author is notified via email, replies, and integrates QA into the 

session for playback for all participants
– QA and slide text searching
– statistics
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Lecture123 Usage

• Academic
– In-class lectures
– Out-of-class supplemental 

content
– Homework/recitations
– Case Studies
– Tutoring sessions
– Student presentations
– Recorded grading session
– Virtual office hours
– Distance learning
– Staff development

• Corporate
– Corporate communications
– Staff training & 

development
– Meeting capture
– Sales force
– Collaboration
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Integrates with Learning
Management Systems

• WebCT

• Blackboard

• eCollege

• others

• Simply copy/paste 
Lecture123 session URL 
into other systems
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Basic Flow

• The basic flow of your content
– Author/Presenter (content owner)

• Compose your content in your favorite authoring tool
• Present and record your session
• Publish

– Participant (viewer)
• Playback
• Ask Questions
• Search for text in question/answers and on slides

– Author
• Answer Questions
• Monitor and Manage content
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Web Based Architecture
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Internet
Viewers

Content
Producers

Lecture123 Servers

Playback
• Any computer
• Any time
• Any place
Ask Questions

• Present
• Record
• Publish

• Presenter & LecturePlayer
Program Delivery

• Content Repository
• QA Collaboration
• Delivery



The Lecture123 Mission

• Collaboratively evolve a repository of 
learning modules that is easy to use 
and universally available

• Connect the Communities
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The whole is greater
than the sum of the partsLectures
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Office HoursStudent
Presentations

Reference

Tuto
rin

g

Review

Exams

Study

New Curricula

Research

Online
Learning

Index
Search

Retrieve

Academic Vision



Corporate Vision

Meetings
Research

Documents

Sales
Presentations

Reference
Communications

Index
Search

Retrieve

Where the whole is greater
than the sum of the parts

Shared

Reusable

Evolving

Collaborate
Content

Metamorphosis

Edit

Re-purpose

Edu-Wiki

…
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Equipment

• Presenter Recording
– Tablets
– SMARTBoard
– Any PC: mouse, ext. tablet

• Participant Playback
– Any PC
– Delivered via network or 

external media, e.g. CD-
ROM or USB memory 
keys

• Live: LCD Projector & 
Screen 

• Microphone
– Built-in
– Wireless for mobility

• Lavalier or Bluetooth

• Internet Connection Optional
– Present/Record off network
– Publish later on net
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Tablets
Word for the wise…

• Start practicing with the pen now
• Turn off the touch pad (e.g. Fn-F9 for Toshiba)
• No mouse
• Just the pen!
• For everything including Lecture123
• Always calibrate pen in a new setting

– Start > Control Panel > Tablet and Pen 
Settings > Calibrate…
(create a Desktop shortcut)
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Microphone
• Connect wire from receiver unit to mic jack in front of tablet
• Test with start > Accessories > Entertainment > 

Sound Recorder (create Desktop shortcut)

• If the volume is not loud enough
– start > Control Panel > Sounds and Audio Devices
– On the top menu click the Voice tab
– Under Voice Recording click the Volume… button
– Find Microphone and make sure that the volume slider is up 

towards the top and Select is checked
– Click on Advanced under Microphone (may need Options >
Advanced Controls)

– Under Other Controls make sure that 1 Mic Boost is checked 
and number 2 Mic2 Select is not selected

– Exit these windows and you’re ready to test again
• For more details please see 

http://www.lecture123.com/elearning/audio.html



LCD Projector

• Turn projector on
• Connect video cable to back of computer
• Function key to enable video out port

– Hold & tap until LCD/CRT and release
(e.g. Fn-F5 on Toshiba tablet)
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Communities and
Login Accounts

Access to Lecture123 Content



The Main Web Site
http://www.lecture123.com

• Let's start with the 
main web site.

• You will find 
shortcut links in the 
left frame.

• The red 
Participants area 
has link to login and 
one to the 
Lecture123 tools. 
The next 2 sections 
review how to login 
and the installation 
instructions.

• The green Free Use
area has a free trial, 
install, and a getting 
started page.
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Login/Access Control

• All content in Lecture123 resides in a community 
repository.

• In order to access content you must create a login 
account. Each login account may subscribe in one or 
more communities.

• A detailed description on this login and access control 
system is found on
http://www.lecture123.com/elearning/jsp/login_help.jsp

• The next several slides describe how to setup your login.
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Creating Your Login Account
• Click on the Login link in the red Participants area on the 

main Lecture123 web page.
• If you are creating your login for the first time, click here.
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Define Your Login
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• Select the community for your login account.
• Each community has a secret key which allows you to enroll –

someone (e.g. author) must give you this key.
• Enter the remaining information and click on Create Account.



Toolbar

• Once you login to Lecture123 most web pages will 
have a toolbar on the top right portion of the page.

• Click on the desired task you wish to perform.

• The toolbar also shows you
– the name of your current login account
– the community your are actively using

if you're subscribed in more than one community use this 
menu to switch between your communities
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Subscribing to Multiple 
Communities

• You may subscribe your 
login account in more 
than one community (e.g. 
if each of 3 classes you 
are taking are in a 
separate community).

• Simply click on Account 
in the toolbar and then 
the "additional 
communities" link on the 
bottom of your Account 
Details page.

• Select the community, 
enter the key and submit.

• Switch between 
communities with the 
menu in the toolbar.
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Installation and
First Time Use

Lecture123 One Time Installation



One Time Installation
http://www.lecture123.com/elearning/install.html 

• Click on “Install” in the green 
Free Use area of the main 
web page on 
http://www.lecture123.com
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• Click to download the “Player”
or the “Presenter and Player”
installer program.

• Run the installer program.

• Take note of the Minimum 
System Requirements.

• Continued on next slide…

http://www.lecture123.com/


Lecture123 Installer Program
2 31

5• Normally the installer 
runs through steps 1-4.

• The Java Runtime 
Environment (JRE) from 
Sun Microsystems will 
be installed if not 
already there.

• If you don’t have 
Administrator privileges 
(step 5), run the installer 
again as Admin to install 
JRE.

4
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Installer Completion

• Once the Lecture123 Installer program has 
completed you will have 2 (“Player” install) 
or 3 (“Presenter and Player” install) icons 
on your computer desktop.

• You will also find Lecture123 in your 
start > All Programs menu.
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Running the Lecture123 Presenter 
or  Player for the First Time

• Every time you start the Presenter or Lecture123 
Player you will see this "Java Loading…" window.

• The system then checks to see that you have the 
latest version of the program.

• If this is the first time you are running the program 
or there is a newer version now available, a Java 
Web Start window will appear showing the 
program download progress. You do not need to 
do anything.

• If prompted with this "Security Warning" window, 
you should click on "Start". This will launch the 
program.
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The Lecture123 Folder
on Your Computer

• A Lecture123 folder is created automatically under you’re
My Documents folder.

• Typically you do not need to access this area as the Lecture123 tools 
look in these folders by default. These details are provided to 
familiarize your in the event the Lecture123 support team advises you 
to look in this area of your disk.

• There are 2 sub-folders in your Lecture123 folder:
– captured: this is where sessions recorded with the Presenter are 

stored. Each session is stored in a path as follows: 
Lecture123\captured\c.comm\f.fld\l.lec
where c is the community, f is the folder, and l is the lecture name. Any 
lecture that has not been published is stored in
captured\unpublished.comm\unpublished.fld

– converted: this is where Lecture123 stores the zip files containing the 
converted file sets from your original source files.
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The Presenter

Present and Record Your Session



Presenter Overview

• The Presenter presents your content while recording 
your voice, mouse or pen annotations, and slide 
navigation.

• Presenter is designed to support content that can be 
printed (similar to the way Acrobat supports PDF from 
any application). Currently PowerPoint source content is 
supported.

• Once you are done recording, the Presenter allows you 
to publish the session for playback over the Internet.
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Prepare Your Equipment & Content
• You may present and record your content on any computer.

• Tablet PCs work nicely as you can use the pen to write and draw.

• You need a microphone to record your voice. Wireless mics allow you to 
be mobile. Otherwise a built-in mic, wired mic or headset works.

• Use an LCD projector if you are presenting in a live setting (e.g. 
classroom, meeting).

• Do the one time Presenter installation. It's best to run a quick test with 
the Presenter in advance to ensure that everything is functioning.

• Make sure your voice is being recorded and the quality is good. There's  
a volume meter in the Presenter. It might help to test the mic with a 
recording program on your PC, e.g. Windows SoundRecorder. Or run a 
quick Presenter whiteboard session and play it back in the Player.
See http://www.lecture123.com/elearning/audio.html

• Your content must be converted to Lecture123 format in the Presenter 
while network connected.

• You may record with the Presenter without a network connection -- just 
defer the publishing step until you are connected to a network again.
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Preparing your Content for the 
Presenter

• Create your content with your authoring tool of choice, e.g. 
PowerPoint.

• The source content must be converted to a common file format 
before presenting and recording it in the Presenter. This conversion 
uploads the source file to the Lecture123 server which converts it 
and downloads it back to your computer.

• This conversion process is accomplished with the guidance of the
Lecture123 Presenter startup wizard.

• If you are presenting/recording in a location without a network, you 
must run the wizard in advance.

• The wizard knows if a converted file set exists for a given source file 
and only connects with the Lecture123 server as needed.
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Adding Hypertext Links in Your Content
• You may add hypertext links in your content that can be active in 

both the Presenter and Player.

• Simply include text that defines a valid URL, e.g. 
http://www.lecture123.com in your source content.

• The URL must be fully qualified, e.g. http://www.lecture123.com
(not www.lecture123.com)

• This link will then be clickable in both the Presenter and Player and 
will launch the application defined by your computer, e.g. load a 
page in a web browser or launch a video player.

• Note: the Presenter only records content displayed in its window. 
The launched application will not be recorded. However your voice 
will. You may wish to narrate your use of this launched application.

• Tip: an alternate method is to include screen shots in your source 
content so viewers can see the application.
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Recording with the Presenter
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• Start the Presenter by clicking on a Desktop icon or on the Presenter link 
after clicking Record in the toolbar.

• The following program 
window appears.

• Click Start to launch the 
startup wizard.



Startup Wizard
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• The startup wizard 
steps you through the 
process to starting 
your recording 
session.

• Select the type of 
source content you 
are presenting:
– PowerPoint
– Blank slides
– Converted slideset 

(useful if you've 
previously setup a 
lecture for 
presentation that 
might be stored on 
external media)



PowerPoint Wizard

• If you select 
PowerPoint, then you 
must navigate to 
folder with your ppt 
file, single click the 
desired file, and click 
on Next.
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PowerPoint Conversion Wizard
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• The Presenter then sends your PowerPoint file to the Lecture123 server 
to be converted to a common file format (if a current converted file set 
already exists on your computer, the wizard skips this step).

• Upon completion the converted file set is downloaded to your computer 
and ready for the recording session. Click Next.

1 2



Ready to Start Recording
• Now the Presenter is 

ready to start 
recording.

• Click “Present/Record 
Now” to start.

• If you started the 
Wizard by selecting 
"Blank Slides" 
(instead of 
PowerPoint) or if you 
had previously 
converted your 
source file, then the 
previous windows will 
be skipped and the 
wizard will display this 
window immediately.
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Preparing PowerPoint for a Later 
Recording Session

• Sometimes you wish to prepare a 
PowerPoint file for presentation 
and recording at a later time, e.g. 
if your classroom does not have 
a network connection.

• Once the Presenter wizards says 
the lecture is ready for recording 
you may click on "Later".

• When you are ready to record, 
launch the Presenter, select the 
same PowerPoint file again. This 
time the Presenter knows that 
you've already converted the ppt 
file and will show this window.

• You may then begin to record by 
clicking on
“Present/Record Now".
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Recording…

• Now that you've 
told the wizard to 
being the lecture  
Presenter will 
load your slides 
in the thumbnails 
on the left, show 
slide 1, and beep 
so you know 
your recording 
has started.

• The next slide 
orients you to the 
layout of the 
Presenter
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Presenter LayoutThumbnails: click 
to present slides in 
any order
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Pen tools
(details on next slide)

Timer: shows elapsed 
recording time

Prev/Next buttons 
navigate through slides

Click to mute
your audio

Audio volume 
meter

Stop your recording 
and enter the 
publishing stage

Annotate your 
content with the 
mouse or tablet pen

Pause/Resume 
your recording



Presenter Pen Tools

color
selector
palette

current
color

pen
width

pen

highlighter insert
blank slide

• The 2 drawing tools are pen and highlighter. The grayed icon, giving the 
button a pushed-in feel, is the active drawing tool (e.g. pen is active above).

• Click the desired color in the color selector palette. This changes the current 
color for the active drawing tool.

• Click the pen width selector to resize the active drawing tool.
• The current color and pen width settings are applied and saved individually 

for each drawing tool.
• Click insert blank slide to leave the current slide and continue with a new, 

blank slide (e.g. if you want to draw a diagram or an equation).
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Lecture Repository Overview
• Recorded sessions (i.e. lectures) are stored on the 

Lecture123 server during the publishing phase in the 
Presenter.

• As the content owner you give each lecture a name and 
specify a community and folder where it resides.

• You may create new folders as necessary.

• Every lecture is accessible for playback with a unique 
URL. On the Play web page simply right-click on any 
lecture link shown in your web browser and copy the 
URL; then paste this URL anywhere you wish. 

• Lecture playback URLs can emailed or placed on any 
web page (e.g. in a course management system).
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Stop Recording: Publish for Playback
• Once you click on "STOP Lecture" the 

Presenter initiates the publishing phase.
• Select the "Community", the "Lecture Folder" 

and "Lecture Name".
• Any questions posted in playback are sent to 

the "Author Email" you enter.
• Click "Publish" to upload the recorded session 

to the Lecture123 server.

• First the local files are zipped together and 
then the progress of the upload to the 
Lecture123 server is displayed.

• When the upload is done and the session has 
been published in the server repository for 
playback simply click on "Finish".

1

2

3

4



Publishing Later

• You may choose to publish your recorded session later if 
you are not connected to the network or do not have the 
time to do so now.

• After you've stopped the recording in the Presenter it's 
fine to click on "Publish Later" and exit the Presenter or 
record another session (using a different save folder).

• When you are ready to publish this lecture and are 
connected to the network simply start the Presenter and 
click on "Publish Existing Lecture" in the "File" menu.

• This initiates the publishing phase again. You start by 
navigating the file chooser to the folder containing the 
recorded session on your local disk. By default the file 
chooser starts in the “unpublished” folder.

• Now step through the publishing instructions shown on 
the previous slide.
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Ready for Playback

• Now that you have recorded your session in the 
Presenter and published it to the server your 
content is available for playback.

• Viewers can access the content through a web 
page available from the Lecture123 web site or 
via URLs you have posted (e.g. in email or on 
your own web pages)
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The Lecture123 Player

Playback



Lecture123 Player Overview
• The Lecture123 Playback web page allows you to view all lectures

stored on the server.

• Content is accessible via the URLs defined earlier in this document.

• Lectures can be played in a variety of ways:

– Full content mode where the viewer experiences the lecture with 
synchronized slide navigation, the author's voice and annotations, and 
any questions/answers.

– Slideshow mode shows the slides and annotation without audio or QAs 
and is useful for quick access (e.g. over dialup connections) or printing.

• The player offers several methods to navigate through the lecture 
including a time slidebar, slide thumbnails, prev/next, and by-QA.

• During full content playback viewers may post questions into the
lecture. These are answered by the author and automatically 
integrated into the lecture.

Lecture123 Training Copyright © 2005 Lecture123.com Corporation 58



Playback
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• The "Lecture123 Playback" (click Play in toolbar) web page allows you to 
view all lectures.

• Click the red lecture name to launch the Lecture123 Player with the desired 
content.

click here for
slideshow
Playback
(no audio)

select a
folder or
view all



Lecture123 Player Navigation
• Once the player is displayed click "Play" to start.
• This slide shows the various way to navigate through the lecture:
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thumbnails:
shows all slides; 
click to navigate

Prev/Next:
click to navigate

Play/Pause:
click button 
or icon below

Move slider to play 
from any time point

+-

• Moving the 
slidebar while the 
lecture is paused 
shows the slides 
and annotations as 
fast forward or 
reverse.

• The player window 
may be resized. A 
non maximized 
window shows a 
time popup when 
the mouse is over 
the slider. volume

mute

speed



The File Menu

Lecture123 Training Copyright © 2005 Lecture123.com Corporation 61

• The File menu allows you to print or load lectures into the Lecture123 
Player:
– Print Lecture: launches a window to print the lecture currently open in the 

player.
– Open Lecture: open and play the lecture specified in a file chooser that 

allows you to navigate to a lecture folder on your hard disk or other media 
(e.g. CDROM or flash memory key). This can be used to review a session 
recorded in the Presenter before it is published.

– Open URL: displays the current lecture URL and allows you to enter and 
load a different lecture.

– Reload: reloads the current lecture from the start; causes all related files to 
be reloaded. Useful method to refresh newly posted QAs.

– Exit: exits the player.



The View Menu
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• The View menu provides various ways to experience the playback of 
content. You may change the mode while the player is active.
– Slideshow Mode: is used for quick viewing of slide content only (no audio, 

no QAs).
– Show Scribbles: turn the pen annotations on/off.
– Show QAs: turn the display of QA marks on the slides on/off.
– Show QA Window: displays a separate window listing the details. 

associated with each QA.
– Mute QA sound: mute the chime sound activated each time a QA marker 

is displayed on a slide.
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QA Collaboration

Questions and Answers



QA = Questions/Answers
• Viewers may easily ask a question at any time during playback.

• Questions carry full context including the lecture folder and name, the 
slide number, the time when it is asked, and the slide location where the 
Q click occurred.

• All QAs are stored in a server repository.

• The content owner is notified via email when a new Q is posted. This Q 
with full context is available so an appropriate answer can be made.

• These QAs are automagically integrated into the content for all 
subsequent viewers benefit.

• QAs are not available in the content until they are approved by the 
content owner.

• QAs may also be searched for specified text.

• Finally, content owners may view QA histograms and take appropriate 
action, e.g. by creating a new mini lecture with the Presenter to reinforce 
an aspect of the original content.
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QA Help Dialogue
The QA help dialogue is displayed on player 

startup.

• You may disable this by 
checking “Don’t show this 
again”.

• The dialogue maybe accessed 
from the QA menu at anytime: 

– QA->Show QA Help Window

A

A

B

B
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Ask a Question in the Lecture123 Player
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• At any time during content playback the viewer simply right clicks the 
mouse on the slide location pertinent to the question.

• This pauses the player and displays a question window.

• The viewer types in the question and optionally enters her email
address to get a confirmation email and for any private email dialog with 
the content owner.

1

2

1

2

3

3

• Click the submit button. The 
question text along with all the 
context details are sent to the 
Lecture123 server. The server 
then:

– stores the Q in the QA 
repository

– emails confirmation to the 
poster of the Q (if they provided 
an email address in the Q).

– emails a notification to the 
content owner

4

4



QA Email Notice to Author
• The content owner (aka author) receives email at the address specified 

during the publishing phase in the Presenter after the session was 
recorded.

• The email body contains the question details.

• Click the URL at the bottom of this email message to visualize and then 
answer the question in a web browser (see the next slide for details).
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• Only the author (or 
Admin) can manage 
QAs. Others can only 
view the QA. This is 
apparent with the 
different author and 
participant web pages 
that are displayed.



Answer the Question in a Browser
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• The URL in the email notification loads the image of the slide in the left 
frame along with the QA circle mark.

• The right frame shows the details.

1

1

2

• Type your 
answer and 
click submit.

• Approved 
answers are 
stored in the 
QA repository 
and integrated 
into all future 
playback of this 
content.

3

You may visit other 
slides to assist in 
answering the 
question

If there are multiple 
QA marks, click 
any one for details 
in right frame

2

3

You may launch the 
player directly to the 
time of this QA

Approve (include), 
Unapprove (un-include but 
not deleted), Delete, and/or 
Email directly with the asker



HTML Enabled QA

• You can add a whole new dimension to your sessions 
with this QA channel.

• You may include HTML code in the answer for a QA.
• This allows you to create a link out to another web site, 

Lecture123 session, a test, or anything that has a URL.
• You may also include a picture to help answer the question. 

Imagine adding a supply-demand graph in your answer.
• Try a table or a form.
• Examples:

– Here’s a link:
<a href=“http://www.lecture123.com”>Lecture123</a>

– A picture:
<img src=“http://www.lecture123.com/elearning/logo.jpg”>
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HTML Enabled QA
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1

1 Format your 
answer 
using the html 
editor.



View All Slide QAs
• You may view all the QAs for this slide by clicking on the “View All Slide 

QAs”. This is useful for a composite view.

• The right frame shows all the QAs.

• You may click on any Q3 to view the detials for that single QA.

1

2

3

1
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Experiencing QAs in the Lecture123 Player
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• In the “QA" menu select "Show QAs" and 
"Show QA Window".

• The "QA Window" is displayed. During 
playback the "QA Window" updates as each 
QA posting time is reached.

• Click "QA navigates lecture".

• Click any entry in the "QA 
Window" left pane to cause 
the player to move to the time 
that QA was posted.

• You may also click on QA 
marks on a slide to update the 
"QA Window" with the details 
of that QA.

• "Reload" in the "File" menu 
will update any newly posted 
QAs

1

2

3

4

5

1

2

3

4

5
6

• You may resize the Presenter window
to view both windows

6
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QA Feedback

Browse Lecture QAs
View Histogram

Display Slides with QAs



Feedback to Content Owners

• Content owners can monitor the number of playbacks for 
each lecture.

• Additionally, summaries of posted QAs are provided.

• These features offer methods for Continuous Quality 
Improvement (CQI) of content and the development of 
appropriate action plans.
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Browse QAs 1

2

3

• Start by clicking on Play in the 
toolbar.

• Click on the number in the QA 
column for the desired lecture.

• Click on the Q#
• View the slide QA Details
• Click any QA on left for details

1

2

3
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QA Histogram
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• Click on “View QA Histogram” on 
the “Browse Lecture Questions”
page

• The histogram is displayed with 
slide numbers on the x-axis and 
the number of Qs on the y-axis

• Click on any histogram bar

• View that slide and click a specific 
QA circle or the “View All Slide 
QAs” button

• The lecture owner might
identify hotspots and
consider appropriate action

– review topics
– refine slides
– Create a mini Lecture123

session and send
to participants

1

2

3

1

2

3
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QA and Slide Searches



QA Searches
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• Users may perform QA and slide text searches by clicking the toolbar “Search”.
• Narrow your search by all or specific communities, folder and lecture, select 

search type (slide and/or QA), enter the search text, and click “Start Search”.
• The results page shows all matching slides across the specified lecture set 

where the text occurs in QAs and/or slide text.

1

2

3

1

3

2

• You may then click 
through to view:

– The slide in the 
browser with the QA 
text

– The full lecture in the 
Player at the time  
where that QA 
occurred

– The full lecture in the 
Player at the time 
where the slide with 
that text occurs

4

5

6
45

6
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Podcasts



Podcasts
• During the Presenter publishing step you select 

whether you want audio and/or video podcasts for 
the session you are publishing.

• The podcast subscription is separate for each 
Lecture123 community.

• Simply click on the podcast link on the playback 
web page for the desired community.

• The next several pages walk through the flow 
from the Lecture123 playback web page to 
podcast delivery onto your  external player.
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Enable Podcasts During Publish
• When you publish your 

recorded session in the 
Presenter, select the 
podcast checkboxes in 
order for the audio or 
video to be made 
available in the 
community podcast
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Enabling Podcasts for Sessions Already Published
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1

2

• If you did not enable 
podcasting in the 
Presenter publish 
step, you may do so 
by clicking on the 
‘Manage Lectures’
link in the blue 
toolbar when logged 
into the web site

• After your click 
“Update Lecture”
you will be sent an 
email when your 
session podcast is 
ready for use



Find the Podcast Link on the 
Community Playback Web Page

• Login to Lecture123 with 
your web browser.

• Click on the Play link in 
the blue toolbar.

• Select the community 
where you want a 
podcast.

• Click on the podcast link 
on the playback page.

1

2

3

1

2

3
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Launch Your
Podcast software
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1

2

3

• iTunes users should click 
on that button for audio 
or video on the podcast 
web page.

• You may also copy/past 
the URL into your 
podcast software.

• The podcast software 
will launch

• A podcast entry is made 
with the name of the 
Lecture123 server and 
community selected.

• Sessions will be 
downloaded to your 
podcast software.

1

2

3

4

5

4
5



Getting Additional Sessions in the Podcast

• Depending on how your podcast software is configured you may need 
to manually download sessions listed in the podcast.

• iTunes has a GET button to download the session.1

1
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Organizing Podcast Sessions
• Lecture123 podcast are sent to your software with 

specific session information, e.g. the server, repository, 
community, folder, lecture name, author, #slides.

• You may need to enable various library headings in 
your software to see these details. In iTunes right-click 
on the heading line and select columns like Album, 
Artist, and Description.

• You may then sort the list in iTunes by clicking on the 
column heading. This allows you to see sessions from 
the same community grouped together.

2

1

1

2
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Access & Playback Audio
Podcast on Your Player

1

2

3

4

5

Lecture123 Training Copyright © 2005 Lecture123.com Corporation 87



Access & Playback Video
Podcast on Your Player1

2

3

4

5
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Management

Monitoring and Managing Your 
Content



Monitoring Lecture Playback
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• The "Lecture123 Playback" web page allows you to monitor lecture playbacks.

• The "Playbacks" column shows the number of playbacks.

• Click the number to see the timestamp and IP number of each playback.

1

2

3

1

2

3



Monitoring Lecture QAs
• The "LecturePlayback" web page allows you to monitor lecture QAs.

• The "QAs" column shows the number of QAs posted for each lecture.

• Click the number to see the list of all QAs for that lecture.

• You may then click the Question number to see the slide and QAs.

• Or "View Histogram" for feedback on all QAs for this lecture.

1

2

3

4

5
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Author Lecture Management
• Authors of Lecture123 

sessions will see “Manage 
Lectures” in the web toolbar

• This allows authors to:
– Copy, Move, or Delete 

published lectures
– Manage lecture 

properties, e.g. change 
the author email or 
enable a podcast

Lecture123 Training Copyright © 2005 Lecture123.com Corporation 92



Copy/Move/Delete Lectures
• This allows authors to:

– Delete a lecture

– Move or copy a lecture
• With or without the QAs
• Move to same folder to 

simply rename the lecture
• To a different or new 

folder
• In the same or different 

community
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Manage Lecture Properties
• This allows authors to:

– Change the Author 
Email address, e.g.  
email notices are sent 
when students ask 
questions.

– Enable or disable audio 
and/or video podcasts 
for the selected lecture 
session. An email is sent 
to the Author Email once 
a podcast is ready for 
use.

1

1

2

2
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Administrator Functions
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– Create new 
communities

– Edit community 
properties

• Key
• # Authors
• # Participants
• Login & publish 

rules

– Edit community 
membership

• User properties
• Assign authors

• Administrators have “Manage Communities” on their web 
toolbar and may:
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Course Management 
Systems



Course Management Systems &

• All recorded lectures are accessible as URLs
– Author is emailed the URL when lecture is 

published
– These URLs can be inserted into any course 

management system
– URLs can also be emailed
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Thanks!!

This concludes this training document.
Please send any questions or feedback to 

support@lecture123.com

mailto:support@lecture123.com
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